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CHAPTER 5: DATABASE 

Introduction to Databases 
A database is an organized collection of data. It is the collection of tables, queries, reports, 

views, and other objects. The data are typically organized to model aspects of reality in a way 

that supports processes requiring information, such as modelling the availability of rooms in 

hotels in a way that supports finding a hotel with vacancies. 

A database management system (DBMS) is a computer software application that interacts with 

the user, other applications, and the database itself to capture and analyze data. A general-

purpose DBMS is designed to allow the definition, creation, querying, update, and administration 

of databases. Well-known DBMSs include MySQL, Oracle and MS Access 

Traditional File Organization 
Traditional file organization refers to an approach to organizing computer-based or electronic 

files. Prior to computer databases, many businesses simply organized files by creating folder 

structures and placed documents and files into folders based on category or type. This method 

has given way to database systems in many cases. However, traditional filing is sometimes 

advantageous if you have a relatively small number of files. 

 

Simple to Use 

The traditional filing system is very simple to set up and use, assuming the number of files you 

maintain is small. If you have five basic categories of documents and a limited number of files in 

each, for instance, you don't need a database system to easily store, maintain and retrieve your 

files. You also don't have to worry about learning a software system and training employees to 

use it. 

 

Minimal Investment 

If you're using a traditional filing system, you also don't have to make an investment in a 

software database that may include an upfront purchase and ongoing licensing fees. Naturally, 

you need a computer, which is fairly commonplace in business whether you store files or not. 

Your basic file structure is maintained right in your computer's hard drive. Alternatively, you can 

purchase a very inexpensive external hard drive that allows you to transport files from one 

computer to another. 

 

Poor Data Integration 

A major deficiency of the traditional filing system is that it doesn't enable cross-file data 

integration or data sharing. With a software-based filing system, you can maintain various 

folders but you can cross-match searches to retrieve documents in multiple files. Additionally, 

you can enable multiple employees to search through shared data files. This integration reduces 

time to search through all individual files, a benefit that's especially important if you maintain a 

large amount of files or have a large client base. 
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Duplication and Lack of Security 

You also risk duplication of data if you don't integrate your files through a database. In a 

traditional system, your computer doesn't recognize that you create similar documents and store 

them in different file locations. Additionally, your traditional filing system doesn't offer nearly 

the level of security that a carefully crafted database filing system does. Encrypted data and 

current security are key features as company's regularly develop enhanced database systems. 

 

What are Data Models? Type of Data Models.  

A model is a representation of reality, 'real world' objects and events, associations. It is an 

abstraction that concentrates on the essential, inherent aspects an organization and ignores the 

accidental properties. A data model represents the organization itself. It should provide the basic 

concepts and notations that will allow database designers and end users unambiguously and 

accurately to communicate their understanding of the organizational data. 

Data Model can be defined as an integrated collection of concepts for describing and 

manipulating data, relationships between data, and constraints on the data in an organization.  

A data model comprises of three components:  
 A structural part, consisting of a set of rules according to which databases can be constructed.  

 A manipulative part, defining the types of operation that are allowed on the data (this 

includes the operations that are used for updating or retrieving data from the database and for 

changing the structure of the database).  

 Possibly a set of integrity rules, which ensures that the data is accurate.  

The purpose of a data model is to represent data and to make the data understandable. There have 

been many data models proposed in the literature. They fall into three broad categories:  

 Object Based Data Models 

 Physical Data Models 

 Record Based Data Models 

The object based and record based data models are used to describe data at the conceptual and 

external levels, the physical data model is used to· describe data at the internal level.  

Object Based Data Models  
Object based data models use concepts such as entities, attributes, and relationships. An entity is 

a distinct object (a person, place, concept, and event) in the organization that is to be represented 

in the database. An attribute is a property that describes some aspect of the object that we wish to 

record, and a relationship is an association between entities.  

 

Some of the more common types of object based data model are:  

• Entity-Relationship  

• Object Oriented  

• Semantic  

• Functional  

http://ecomputernotes.com/fundamental/what-is-a-database/type-of-data-models
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The Entity-Relationship model has emerged as one of the main techniques for modeling database 

design and forms the basis for the database design methodology. The object oriented data model 

extends the definition of an entity to include, not only the attributes that describe the state of the 

object but also the actions that are associated with the object, that is, its behavior. The object is 

said to encapsulate both state and behavior. Entities in semantic systems represent the equivalent 

of a record in a relational system or an object in an OO system but they do not include behaviour 

(methods). They are abstractions 'used to represent real world (e.g. customer) or conceptual (e.g. 

bank account) objects. The functional data model is now almost twenty years old. The original 

idea was to' view the database as a collection of extensionally defined functions and to use a 

functional language for querying the database.  

Physical Data Models  
Physical data models describe how data is stored in the computer, representing information such 

as record structures, record ordering, and access paths. There are not as many physical data 

models as logical data models, the most common one being the Unifying Model.  

 

Record Based Logical Models 

Record based logical models are used in describing data at the logical and view levels. In 

contrast to object based data models, they are used to specify the overall logical structure of the 

database and to provide a higher-level description of the implementation. Record based models 

are so named because the database is structured in fixed format records of several types. Each 

record type defines a fixed number of fields, or attributes, and each field is usually of a fixed 

length.  

 

The three most widely accepted record based data models are:  

• Hierarchical Model  

• Network Model  

• Relational Model  

The relational model has gained favor over the other two in recent years. The network and 

hierarchical models are still used in a large number of older databases. 

Introduction to Microsoft Access 
MS Access is a database management tool that enables one to have good command of data 

collected. The programme enables one to retrieve, sort, summarize and report results speedily 

and effectively. It can combine data from various files through creating relationships, and can 

make data entry more efficient and accurate.  

Microsoft Access (MS Access) enables one to manage all important information from a single 

database file. Within the file, one can use:  

 Tables to store your data.  

 Queries to find and retrieve specific data of interest.  

 Forms to view, add, and update data in tables.  

 Reports to analyze or print data in a specific layout.  

 Data access pages to view or update, the data.  
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In MS Access, data is stored once in one table, but can be viewed from multiple locations.  

When the data is updated in a Table, Query or Form, it is automatically updated everywhere it 

appears  

 
Microsoft Access is a relational database management system for windows. Using this package, 
following tasks can be performed. 
 
 Organize data into manageable related units Enter, modify and locate 

data   
 Extract subsets of data based on specific criteria Create custom forms and 

reports   
 Automate common database tasks Graph database 

relationships  
 Add clipart to forms and reports  
 Create macros for automating various functions   
 Create database applications, consisting of modules linked through menus, dialog boxes, 

and command buttons.   
 In Access, the term Database refers to a single file that contains a collection of 

information. Each Access Database consists of tables, queries ,forms reports, macros and 
modules  

 

Database Concepts 

Field Names 
These should be meaningful, without spaces or punctuation, such as SNAME (surname), 
FNAME (first name), DOB (date of birth), ADDRESS1 (first line of address), TOWN, PCODE, 
PHONE etc. You cannot have two fields with the same name. 

 

Field Types 
 Text for text and whole numbers that aren‘t going to be used in calculations(e.g., age, 

phone number)  
 Date/Time for dates and time   
 Numbers for decimals and numbers that are going to be used in calculations, e.g. sales 

figures  
 Currency for money   
 Yes/No for true/false logical values, e.g. a ―married‖ field, field could be logical.  

 

Field length 
This has to be fixed, so you need to plan your database structure beforehand (although you can 
alter the length later). 
 

Required Fields 

This box is for when you want to force the user to enter data in a field 

 

Primary keys 
These are used to sort the records to allow fast access. Access encourages you choose one field 
as the primary key field, and then sorts the records on this field. However, only one record with 
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the same value is allowed in the primary key field, for example if you choose surname for the 
primary key, you can only have one Smith, Jones etc. For this reason, you should always choose 
a numeric or a counter field for the primary key: do not use surname as the primary key field. 
 

Introduction to Access 2007 

Microsoft Office Access is enabling information workers to perform data-tracking tasks that otherwise 

would require the time and expertise of professional programmers and database administrators. Even 

professional developers have found that Office Access can save time and meet business requirements 

for many applications. In addition to this, Microsoft has made significant changes and has redesigned the 

user interface and design tools to make them even more approachable to entry level Access users.  

 

What’s New in Microsoft Access 2007 

Access 2007 has gone through an extensive redesign which becomes apparent as soon as you start the 

program.  The program opens up to the Getting Started Page where you can either open an existing or a 

new database or even down-load a professionally built data-base.  And that is not the only change you 

will notice, the top bar has a completely new look called the Ribbon and some great new features have 

also been added.  All of which we will cover in further detail in this document.   

 

Help and How To in Access 2007  

Access 2007 looks very different from the previous versions of Access, and many of the common 

features have been re-categorized.  Therefore, it is strongly suggested that you use the Help Files within 

Access if challenges arise.  The Help Files are assessable by clicking the question mark in the blue 

circle at the end of the Ribbon.  The blue question mark replaces the Office Assistant in previous 

versions.  Help also offers a Super Tooltips, which are screen tips or pop-ups to learn more information 

about the commands function in just a few lines. To activate, rest your mouse over a command. 

Diagrams and pictures may also appear if they apply.   

If you are unable to find your question in the Help Files, search the Microsoft Knowledge Base at 

www.support.microsoft.com or contact your local Help Desk. 

 

                                                     

http://www.support.microsoft.com/
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       Ribbon: An area across the top of the screen that makes almost all the capabilities of Excel 

available in a single area.  The Ribbon replaces the menus and toolbars in previous versions. The 

Ribbon exposes most of the features that were hidden in the drop-down Menus.  The Ribbon 

makes it easier to see and find commands to format your document. 

 Microsoft Office Button: A button that provides access to menu commands in Excel.  The 

Microsoft Office Button replaces the File menu in previous versions.  Here is where you will find 

commonly known features such as New, Open, Save, Print and Recent Documents. 

1 

2 
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Tab: An area on the Ribbon that contains commands organized in groups.  The default tabs 

are Home, Create, External Data, and Database Tools.  

 Quick Access Tool Bar: A customizable toolbar located right above the default tabs. By 

default the Quick Access Tool Bar displays the Save, Undo, and Repeat buttons and is used for 

easy access to frequently used commands.  

 Dialog Box Launcher: A button that launches a dialog box containing options for refining a 

command. 

 Title Bar: A horizontal bar at the top of an active document.  This bar displays the name of 

the document and application.  At the right end of the Title Bar, as in previous versions is the 

Minimize, Restore and Close buttons. 

  Groups Categories: A Group of buttons on a tab that are exposed and easily accessible.  

These buttons were formally embedded in menus on the Menu Bar in the previous versions. 

 Database Window:  Workspace for creating, editing and formatting objects in your database.  

 Navigation Pane: From this pane you can create tables, forms, reports and queries. Easy 

access to any object within your database. 

 View Toolbar: A toolbar that enables, adjusts, and displays different views of 

a database.  

 Status Bar: A horizontal bar at the bottom of an active window that gives 

details about the active document. 

Exploring Access 2007 

Starting Up Access 2007 

1. Click Start button, located in the lower left corner of the Windows task bar.  

2. Point to All programs, click Microsoft Office. 

3. Click Microsoft Office Access 2007. 

3 

4 

5 

6 

7 

8 

9 

10 

11 
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4. Access 2007 will open displaying an empty database. This will happen for the first time you open 

Access. (After that, Access has set the Getting Started Page as the default page.)  Click the 

Microsoft Office Button and then click Close Database. The Getting Started Page will now 

display. 

 

            
    
 
 

 
 

             
             
             
    

The Getting Started Page 

 Professionally designed database templates grouped by category. Here you 

can choose a template category; your options under that category are displayed in 

the center of the screen. From there you can choose to create a blank database 

or download a pre-built database. 

Access to your most recently opened databases. 

 Direct link to Microsoft Office Online Help. 

1

  

2 

3

  

2

  

3

  

1
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The New Access Environment 

The new Access environment has been designed so that its powerful features are easier to find 

when you need them. This design reflects the way in which people generally work within the 

program.  In previous versions, commands were primarily located in a Menu list.  In Access 2007 

the commands are displayed on the Ribbon for easy access.   

 Commands are arranged on tabs, grouped according to the task you want to accomplish.  

Commands are arranged on background tabs that become visible only when they are needed. 

 Tabs are designed to be task-oriented. 

 Contextual Tabs are designed to appear on the Ribbon when certain objects or commands 

are selected. These tabs provide easy access to options specific to the selected object or 

command. 

 Groups within each tab break a task into subtasks.  

 When you point to certain types of formatting options on a tab, the text of that command 

changes to show a Live Preview of the effects of that option.  This means you can do a trial run 

without actually applying changes that you might later need to undo. 

Microsoft Office Button  is located in the upper-left corner of the window.  This button 

manages the following Access commands: Open, Save, Print, Recent Documents, and replaces 

the File menu in previous versions.  At the bottom of the menu are buttons for changing Access 

Options and Exiting Access.  Many of the options available in the Access Options menu are 

located in the Tools menu in previous Versions 
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Tip: Press the escape key or click away from menu to close. 

The Quick Access Toolbar is located to the right of the Microsoft Office Button and was 

designed for easy access to frequently used commands. The Quick Access Toolbar can be 

customized to add such commands as Print and Spell Check. 

 
 

 

The Ribbon is the area across the top of the screen and exposes most of the features that use 

to be hidden in file menus.  The Ribbon makes it easier to see and find the commands to 

format your document.  The Ribbon can be reduced to a single line of tabs by pressing CTRL + 

F1. 

 

 

The Home tab is organized into seven groups related to working with data: Views, Clipboard, 

Font, Rich Text, Records, Sort & Filter, and Find. 
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The Create Tab is organized in four groups: Tables, Forms, Reports, Other.  Here you will find 

quick create commands to help build forms and reports with the click of a button.  These 

enhanced commands create new data entry forms and reports complete with controls and 

graphics. 

 

The External Data tab is organized in four groups: Imports, Export, Collect Data, and 

SharePoint Lists. Here you will find the commands to import data from other programs or even 

through e-mail. 

 

The Database Tools tab is organized in five groups: Macro, Show/Hide, Analyze, Move Data, 

and Database Tools.  Here you find the commands to build relationships between the many 

tables/queries in a database.  Build macros, Launch Visual Basic Editor and so on. 

 

Contextual Tabs appear on the Ribbon when certain objects or commands are selected. 

These tabs provide easy access to options specific to the selected object or command. 
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Creating a New Database 

1. Click the Microsoft Office Button, and then click New.  

2. Click on Blank Database or Click on a Pre-built Database located in the center of the screen  

3. Your choice will appear in the download field,  there you will click on Create 

 

Opening an Existing Database   

1. Click the Microsoft Office Button, and then click Open.  

2. In the Open dialogue box, navigate to the folder that contains the file you want to open, and 

then double-click the file. 

 

Navigating in a Database 

This table list ways to navigate in a database using your Keyboard to move the insertion point in an active 

database 

                                  To do this:     Press………… 

Select the active tab of the ribbon and Activate the 

access keys 

Alt or F10. Press either of these keys 

again to move back to the document and 

cancel the access keys.  

Move to another tab of the ribbon Alt or F10 to select the active tab, and then 

Left arrow or Right Arrow.  

Minimize or Restore the Ribbon Ctrl +F1 

Display the shortcut menu for the selected 

Command 

Shift + F10 

Move the focus to select each of the following areas 

of the window 

 Active tab of the Ribbon 

 View status bar at the bottom of the window 

 Your document 

F6 

Move the focus to each command in the Ribbon 

forward or backward  

Alt or F10 and then Tab or Shift-Tab 

Move down, up, left or right among the Items in the 

Ribbon  

Down Arrow, Up Arrow, Left Arrow or Right 

Arrow  

Activate the selected command or control in the 

Ribbon 

the Ribbon 
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Open the selected menu or gallery in the Ribbon  Space Bar or Enter 

Activate a command or control in the Ribbon so you 

can modify a value 

Enter 

Finish modifying a value in a control in the Riboon, 

and move focus back to the document 

Enter 

 
 
 

Displaying Different Views 

Note - Access offers different View Options depending on the object you are working with, see View 

Options by Object Below.   Access allows different functions and commands to be performed while in the 

different view formats.  

Table:  View Options 

The two views you will use most often when working with a Table will be: 

1. Datasheet View: this is your data entry screen 

2. Design View: this is where you define your data type 

 

   
Form:  View Options 

The two views you will work in most often when working with a form will be:  

1. Layout View: here you design forms and see changes as you apply them 

2. Design View: this is where you would actually design your form, although some changes 

can be done in layout view, many are more easily done here and some changes can only be 

made here.     
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Query: View Options 

The two views you will work in most often when working with Queries will be: 

1.  Datasheet View: here you would filter data in a Query 

2. Design View: here you have access to the tools to make changes to your query   

 
 
 

 

Report: View Options  

The three views you will work with most often when working with Reports will be: 

1. Report View: here you can filter the data and drilldown to print only what you need. 

Just right-click inside a control and select a filtering option from a contextual shortcut menu 

2. Layout View: here you design reports and see changes as you apply them 

3. Design View: this is where you would actually design your report, although some changes 

can be done in layout view, many are more easily done here and some changes can only be 

made her    
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Previewing and Printing an Object 

Click the Microsoft Office Button, point to Print. 

 

 
   

 Print allows you to select a printer, number of copies, and other printing options 

before printing. 

 Quick Print allows you to send the object directly to the default printer without making 

changes. 

 Preview allows you to preview and make changes to pages before printing.   

Saving and Closing a New Database 

 Saving a New Database 

1. On the Quick Access Toolbar, click the Save button; or  
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2. Click the Microsoft Office Button, and then click Save As, the Save As dialog box will 

appear.  In the Save “Object Name “to field, type the name of the object. 

3. Click on the drop down menu in the As field choose type of object you want to convert to.   

4. Click Ok. 

  

        

 

 
 

Closing a New Database 

1. Click the Microsoft Office Button, and then click Close. 

2. A Microsoft Office Access dialogue box will appear displaying a “Do you want to save…?” 

Message 

3. Click Yes to save, No to discard, or Cancel to close dialogue box.  

  

 

Converting and Compatibility Issues 

Converting a Database to a different version of Access  

1. Click the Microsoft Office Button, point to Save As, and then, under Save the database in 

another format, click the file format to which you want to convert. For example, you can click 

Current File Format to save the copy in the same file format as the original, or you can choose 

one of the other file formats. 

2. In the Save As dialog box, type a file name for the copy of the database in the File name box, 

and then click Save. A copy of the database is created and opened; Access automatically closes 

the original database. 
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Compatibility with different versions of Access  

If you need to share a database with someone who has an earlier version of Access you will need to 

create a copy of the database to an earlier format (see instructions above for Converting a 

Database)   

Note – if you use a feature in your database that requires a 2007 format you will not be able to convert 

this database to an earlier version.  Features that will not convert to a previous file format include 

attachments, multi-valued fields, offline data or links to external files that are not supported by earlier 

versions of Access. 

Exploring the Navigation Pane 

The Navigation Pane is located on the left hand side of your screen. If the pane is not open, click F11. 

Otherwise go to the top of the open pane, and click the downward facing triangle.  A drop down list of 

available views will appear. Here you will find all the objects in your open database. Use the 

navigation pane to organize your objects. This pane replaces the Database Window used in earlier 

versions of Access. From here you can create tables, forms, reports, and queries.   
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Navigation Pane features and controls 

         Menu:  Sets or changes the categories by which the pane groups database objects. 

Click the menu to see the category in use.  Right-click the menu to perform other tasks, such 

as starting the Navigation Options dialog box.   

        Shutter Bar:  Expands or collapses the Navigation Pane.  

         Search box:  Find objects in large databases quickly by entering part or all of an 

object name. As you type, the pane hides any groups that do not contain objects that match 

your search text.  

         Groups:  By default, the pane displays visible groups as sets of bars. To expand or 

close a group, click the up or down arrows. Remember that group names changes as you 

change categories.  

         Database objects:  The tables, forms, reports, queries, and other objects in a 

database. The objects that appear in a given group depend on the logic behind the parent 

category. For example, if you use the Object Type category, the pane creates separate groups 

for tables, forms, reports, and so on. In turn, each group displays those objects that logically 

belong there — the tables group displays only the tables, and so on. 

         Blank space:  Right-click the blank space at the bottom of the Navigation Pane to 

perform a variety of tasks. You can change categories, sort the items in the pane, and show 

or hide the details for the objects in each group. 

Exploring an Access Database 
 

The create tab is where you will find the tools to create all the objects that make up a database.   
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